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NEW HealthShare integration

The Address Book is now integrated with HealthShare so practitioners have access to Australia's largest Specialist and Allied Health

directory when sending letters and referrals. This feature requires internet access. Learn more in our HealthShare guide.

NEW Intramail Search 

There is now a search option in Office and Clinical Intramail so you can search your inbox and sent items for mail using the sender's

name, subject, a date range or linked patient.

Office ZED-7492

Staff Username truncates to 10 characters automatically

The "Edit Staff Member" dialog now prevents users from entering usernames greater than 10 characters in

length.

Office ZED-8409
Removal of support for 3rd party SMS providers

Support for "SMS Everyone", "Inspirus" and "Other"(generic) SMS providers has been removed.

Office ZED-8418

Banking Report enhancements

The following changes have been applied to the Banking report:

Removed unused HealthPoint sections from bank reconciliation, deposit & session reports

Widen the payer name column ("On behalf of") to accommodate longer names

Fixed issue to prevent using the same reason text for all reversals made without closing the payment

enquiry form

Updated Bank list label to say, "Show Inactive Bank Accounts" (from "Show All Bank")

The "New page on staff change checkbox is now only enabled if the "Group by staff" checkbox is ticked

Fixed an issue where payments by staff would not print on separate pages with the option "New page

on staff changed" selected

Renamed Bank Reconciliation Report heading from 'Reversals' to 'Cross-Session Reversals to reflect

the data presented more accurately

Office ZED-8432

Getting an error canceling an invoice without a service record

Fixed the error by disabling the action buttons when no service items are in the service item list or in the add

service item box.

Office ZED-8436

Performance issues when third-party service is down

This fix will prevent the Patient records from loading very slowly during the opening of multiple patient

records when the HI service is down.

The IHI check should now be run in the background for each individual patient without slowing down the UI

performance.

Additional information has been added to the MHR Status section of the patient record and will display when

the IHI check is running and if the check times out it will update to display this information.

https://www.healthsharedigital.com/solutions/referrals/
https://help.zedmed.com.au/help/healthshare
https://help.zedmed.com.au/help/intramail-system
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Office ZED-8445

Issue with Overall total in cross-session reversals

The Banking - Batch Details Report now takes into consideration any cross-session reversal transactions in

the overall totals section of the report.

Office ZED-8463
Change date format on the Banking Reconciliation Report

The Banking Reconciliation report now consistently uses "dd/mm/yyyy" as the date format.

Office ZED-8466
Update ZedSMS purchase Link due to change in providers

Updated link to purchase credits for ZedSMS.

Office ZED-8480
Patient Pick List Dialog = Last letter of Family name is cut off

Fixed the font style to prevent the Patient's name from being cut off on the Patient Letter pick list.

Office ZED-8500
Change date format for Reversals on banking reports

Reversal transactions printed on banking reports now use "dd/mm/yyyy" as the date format.

Office ZED-8530

Error 'MIDNIGHT' is not a valid time on the Waiting Times report

Fixed an issue where an error was displayed when Midnight was selected as the End Time on the Waiting

Times report.

Office ZED-8534

Pronoun deleted from Dropdown list management is being incorrectly removed from the patient it was

assigned to

Fixed an issue where clinic-defined pronouns could disappear from the pronouns selected for a patient.

Office ZED-8594

Booking Wait Time Report issues

The Booking Wait Time report will now display changes from the last edit made to an appointment.

Additionally, the report has been fixed to prevent an error when running the report for a single patient.

Office ZED-8596

Linked Appointment Details - Date Details overlap

The Linked Appointment Details dialog has been updated to use text formatting consistent with the rest of

the application.

Office ZED-8598

Patient Type details are cut off in Appointment Details and Attendance Details dialogs

The Linked Appointment Details dialog has been updated to use text formatting consistent with the rest of

the application.

Clinical ZED-8483

Add Ethnicity field to Zedmed Clinical

Capturing or viewing a patient's ethnicity details has been added to the Family, Social & Past History

information in Clinical.

Clinical ZED-8544
Clinical Reports - Various UI Issues on Font Types or Font Size and Labels cut off

Fixed some minor issues with font sizes and labels being cut off in the Clinical reports.
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Clinical ZED-8552
Update Intramail UI in Clinical

Clinical intramail buttons and icons have been updated on main dialog to match those in Office.

Clinical ZED-8561

Result Inbox Error: Unexpected end of command-line 2, column 1

Results Inbox has been fixed to prevent an error when retrieving results for all doctors on clinics with a large

number of doctors configured.

Clinical ZED8574

Enable configuration to limit attachments tab file size in clinical and set default

Added a maximum value in MB's for uploading of files to tabs in the summary views. This can be found in the

Global Options > General tab.

Clinical ZED-8595
Turn on Icon captions by default in Zedmed Clinical

 Encounter icon captions are now turned on by default for users logging into Clinical for the first time.

Clinical ZED-8630

Formatting Issue When Copying Clinical Notes to Letter Writer

 Added a new Paste Plain Text option to the Letter Writer to allow formatted text such as encounter notes to

be copied and pasted into a letter without formatting.

Upgrader ZED-8614
Removal of Zedmed obsolete files and exe from Installer/Upgrader

 The Zedmed Upgrader has been enhanced to remove obsolete files from client installations.

Zedmed v36.1.1

Clinical ZED-8668

PDF viewer unable to view the document - Blank Document

Fixed an issue that may prevent the viewing of older PDF files, especially those produced by scanning

documents

Zedmed v36.1.0

Zedmed 36.1.0 is a major release that introduces a modern theme, integration with accounting software including Xero and MYOB,

HealthLink SmartForm enhancements and pronoun and gender updates.

Shortcuts to specific sections:

Zedmed v36.1.1

Zedmed v36.1.0

New modern theme

Surgical Partners integration

Zedmed v36.1.0 Updates (part of the v36.0.0 release)

Zedmed v36.0.0 HealthLink SmartForms enhancements

Zedmed v36.0.0 Office & Clinical enhancements

Zedmed v36.0.0 Office & Clinical updates

New modern theme

No menus or layouts have changed, but you now have the option to use the new Modern theme or the existing Classic theme.

http://help.zedmed.com.au/#zedmed-v36-1-1
http://help.zedmed.com.au/#zedmed-v36-1-0
http://help.zedmed.com.au/#new-modern-theme
http://help.zedmed.com.au/#surgical-partners-integration
http://help.zedmed.com.au/#zedmed-v36-1-0-updates-part-of-the-v36-0-0-release-
http://help.zedmed.com.au/#zedmed-v36-0-0-healthlink-smartforms-enhancements
http://help.zedmed.com.au/#zedmed-v36-0-0-office-clinical-enhancements
http://help.zedmed.com.au/#zedmed-v36-0-0-office-clinical-updates
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The first time you open Office and Clinical after the upgrade, you will be prompted to choose a theme.

You can have matching or different themes in Office and Clinical. 

You can swap themes at any time if you change your mind.

The first time opening Office - select Modern or Classic.                          To change - Themes > Modern or Classic.

______________________________________________________________________________________________________________________
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The first time opening Clinical - select Modern or Classic. To change - Tools > My Options > Modern or Classic.

Surgical Partners integration

Surgical Partners is a financial management platform that integrates Zedmed with accounting products including Xero and MYOB.

This allows you to use the financial information in Zedmed for a range of financial applications from debtors' management to banking

and payroll. This functionality is enabled by registering with Surgical Partners who will configure Zedmed to send the required

financial data to your accounting software each night.

To learn more, visit https://surgicalpartners.com.au.

Zedmed v36.1.0 Updates (part of the v36.0.0 release)

Clinical ZED-8328

Implemented a new PDF tool to view results and scanned documents in Clinical

Removed the requirement for Adobe Reader from Zedmed.  PDFs can now be viewed (both when embedded

in a result and when attached from a scan) without any external PDF viewer installed.

Office ZED-8252
Access Violation error resolved when deleting an Appointment Type

Fixed an error that occurred when attempting to delete an appointment type from Office

Office ZED-8360

Corrected the Message/Buttons displayed when a Tyro Easyclaim has been canceled.

The message displayed when a user canceled a Tyro Easyclaim has been resolved and the form now allows

another attempt.

Office ZED-8423
Deleted prescriptions are no longer displayed on HealthLink Forms.

Deleted prescriptions were still showing up as selectable options in the HealthLink SmartForm.

https://surgicalpartners.com.au/medical-integrations/
https://help.zedmed.com.au/help/zedmed-surgical-partners-integration
https://surgicalpartners.com.au
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Clinical ZED-8452

The Encounter Timer no longer disappears when resuming an encounter.

Fixed an issue where the Clinical Encounter timer would no longer be displayed after resuming an existing

encounter.

Office ZED-8481

Updated the Appointment and Full day icons for the Modern Theme.

Updated the icons displayed on the Appointment Grid for Appointment and Full Day menu bar options so

they are no longer similar to Zoom In and Zoom Out icons.

Zedmed v36.0.0 HealthLink SmartForms enhancements

For new users, please follow the Zedmed SmartForms installation guide.

For existing users, please follow the manual upgrade guide.

Clinical ZED-8267

Improved the names used for attachments in SmartForms

Each HL7 results file can include several sections, and Clinical Results Inbox displays them as follows:

1. Result View tab.

2. Enhanced View tab - HL7 file includes only 1 additional part.

3. Enhanced View #N - HL7 file includes N additional parts.

4. 2 and 3 are not always present, depends on HL7.

Results in HL7 files added as attachments to a SmartForm will be named as follows:

1. <HL7 FResult Name> (Result View) tab.

2. <HL7 FResult Name> (Enhanced View) tab - HL7 file includes only 1 additional part.

3. <HL7 FResult Name> (Enhanced View #N) - HL7 file includes N additional parts.

2 and 3 are not always present - depends on the HL7.

Clinical ZED-8292

Zedmed's Healthlink SmartForms integration is now upgradeable

The Healthlink SmartForms service installer has been updated from an MSI into an exe file (as used by other

parts of the Zedmed software) so the software is now upgradeable.

Clinical ZED-8332

Healthlink SmartForm will display 1 attachment for HL7 files with 2 records

The functionality of Zedmed's HealthLink SmartForms integration has been improved. HL7 results that

include PIT segments in addition to FT segments will be included as one attachment (as it is done in Clinical,

Results).

https://help.zedmed.com.au/help/zedmed-healthlink-forms-setup
https://help.zedmed.com.au/help/smartforms-manual-upgrade-guide
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Clinical ZED-8379

The 'HealthLink Create Referral' button can be removed from the Encounter toolbar

Doctors can now remove the 'HealthLink Create Referral' button from the encounter toolbar. This is done in

Clinical > My Options > Function Selections tab > Show the HealthLink button.

Clinical ZED-8387

Resolved a scenario where a staff name could appear as the provider in a SmartForm

Resolved an issue that caused the provider details ( Referred By name)  in a HealthLink SmartForm to be

populated with a staff member's details instead of the provider's details, when the staff member's ID was the

same as the doctor's code.

Zedmed v36.0.0 Office & Clinical enhancements

Clinical ZED-7979

New Pathology & Radiology referral templates added to the Clinical Addressbook for:

Australian Clinical Labs Comprehensive Carrier Screen Request = PathologyClinicalLabsCCS

Queensland Ultrasound for Women = RadiologyQUFW

Sydney Ultrasound for Women = RadiologySydneyUltrasoundForWomen

 Vision Radiology = RadiologyVisionCardiac

Pronoun field added to Zedmed Office & Clinical

Added support for specifying preferred pronouns to Zedmed.  Pronouns can be set in either the Office or

Clinical Patient Details forms and are displayed in the following locations.

The selected pronouns will appear when chosen in the patient record Pronouns drop-down.

Enabled at practice and branch level.

Additional pronouns can be added in Practice Setup > Drop-down List Management> Pronouns.
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Office/

Clinical
ZED-1674

Pronouns display:

The header of patient details summary in Clinical.

Title of patient details in Clinical.

Patient record tab in Clinical.

Title of patient details in Office.

Pronouns & Sex at Birth
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Office ZED-8194

Changed "Gender" to "Sex at Birth"

Changed the "Gender" field to read "Sex at Birth" in Office, Clinical and the Patient Merge utility.

See the screenshot above.

Office ZED-8202

Ethnicity is available in the Patient Merge utility

Ethnicity is now available in the Patient Merge utility when merging duplicate records. It is displayed when

Advanced is selected.

Clinical ZED-8215

Changed the default dose for Prevenar 13 Childhood immunization

Updated the dose from 4 to 3 for the 12-month Pneumococcal (13vPCV) Childhood Scheduled Immunisation.

Office ZED-8326

Added the Service date to the Claims screen and Claims Report

Claims Status UI and report now show the date of the service against each item in the invoice.
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Office ZED-8370

Replaced the PDF viewer for the "View Claim" button in Account Enquiry

Updated the application used to view PDFs in Office for Claims. Viewing a claim from the account enquiry

screen is now significantly faster.

Zedmed v36.0.0 Office & Clinical updates

Clinical ZED-8286

Important update. 

Reduced the flicker on the Results Inbox display list

Results Inbox module has been reworked to prevent flickering as users action results.

Office ZED-5462

Resolved an error that occurred when merging patients with the same SMS message

When merging patients that reference the same SMS message, Zedmed Patient Merger will now only move

one copy the message to the merged record. Previously it would report an error and abort the merge process.

Office ZED-5494

The Last (F4) Button now works in Appointments

While searching for patients on the Appointments UI, selecting the Last F4 button now selects the last

opened patient in the appointment search dialog.

Office ZED-7111

The Delete button in Staff Maintenance>Apps Access no longer causes an Access Violation

The Delete button on the staff permissions maintenance dialog, App Access tab, will now remain disabled

until a selection has been made to prevent an error.
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Office ZED-7982

Resolved Error Data too large for variable [ITEM_CODE]. Max len = [8], actual len = [9] when running AMA

Fee Load

The Load MBS/AMA Item By Criteria option now works when the Load from AMA file checkbox is selected

and an AMA load fee file is used. AMA fees will now be loaded as long as the corresponding MBS item already

exists, a report is displayed at the end of the import listing the items that could not be imported.

Office ZED-7983

Resolved Error - Param [NEWSTARTDATE] type changed from [ftSQLTimeStamp] to [ftDateTime] running

AMA Update Fees

The Update Existing MBS/AMA Items with the Load from AMA file option selected will now run without

error and enable the update AMA items.

Office ZED-8233

Statistics report - Referral Doctor criteria now correctly lists all address book entries (not just referral

doctors)

Referral Doctor criteria in the Statistics Report will now only list Referral Doctor contacts who are set as

Available.

Office ZED-8247

Resolved Error "Zedmed Office was unable to load the OLE object file" when you Select or Preview an

archived letter

Fixed the issue with an error being displayed when selecting or previewing patient letters that have been

archived.

Clinical ZED-8248

Resolved Error 'Type ID Mismatch' when importing CDA letters 

When importing HL7 messages that contain XML files with a namespace prefix, Zedmed Clinical will report a

more accurate error instead of returning "Type ID mismatch".
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Office ZED-8362

Resolved an Intramail error in Sent Items

Fixed an error that occurred when viewing sent items in office intramail when the To: or CC: fields contain a

combined total of more than 1000 characters.

Office ZED-8367

A double booking Patient's name will no longer change when editing the appointment.

Modifying an appointment by selecting it from the appointment selector (appointment 'Details' context

menu option), no longer displays a different patient in the appointment selector at the end of the process.


